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Additional Dashboard Item Options

We are currently updating our site; thank you for your patience.

REPORTS DASHBOARD

ADDITIONAL DASHBOARD ITEM OPTIONS

Reports Dashboard is an application that graphically displays critical busi-

ness information onto a dashboard which can be viewed in Realtime.

In Reports Dashboard, when adding or editing dashboard items, there are

multiple options you can use to customize your dashboard report.

Access: Reports Dashboard Icon > Log In

The Reports Dashboard application will open.

DASHBOARD MENU OPTIONS

* When adding or editing a dashboard, if you right click on a dash-
board item column header or title,a menu with additional
options will be displayed.

® Note: Some of the options displayed in
the right click menu are pertinent to the
selected control type (dashboard item) and
won't be available if a different control

type (dashboard item) is selected.
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SHOW OR HIDE DASHBOARD ITEM TITLE

1. Click on Show Captions on either the Design Tab or the right click
menu.
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1. The Show Caption button on the Ribbon will become disabled (‘whit-
ish' in colour).

2. The title of the selected control type (dashboard item) will no longer

be displayed.
® Note: To display the title of the selected con-
trol type (dashboard item) again, repeat the pre-
vious step. The now enabled Show Caption
button on the Ribbon will be 'bluish’ in colour.
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DUPLICATE A DASHBOARD ITEM

e To duplicate a selected control type (dashboard item), click on

Duplicate on either the Home tab or the right click menu.
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* A duplicate of the selected control type (dashboard item) will be

displayed.
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DELETE A DASHBOARD ITEM

e To delete a selected control type (dashboard item), click on

Delete on either the Home tab or the right click menu.
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e The selected control type (dashboard item) will be deleted.
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CONVERT A CONTROL TYPE

1. To change a selected control type (dashboard item), click on Convert

To on either the Home tab or the right click menu.

2. A side menu will pop up, select the control type you wish to convert to.

* In this image, Chart has been selected.
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* The control type (dashboard item) will be converted to the selec-

ted control type.
* In this image, a Chart is now displayed.
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REMOVE DATA ITEMS FROM A DASHBOARD ITEM

* To remove data items from a selected control type (dashboard
item), click on Remove Data Items on either the Home tab or
the right click menu.
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* The data items of the selected control type (dashboard item) will

be removed.
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RENAME A DASHBOARD ITEM TITLE AND OR
COLUMNS

e To edit the title and or column names of a selected control

type (dashboard item), click on Edit Names on either the Design
tab or right click menu.
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* The Edit Names screen will be displayed.
* Make the required changes.
* Click on Ok.
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* The changes will be saved.
* In this image, the title of the selected control type
(dashboard item title) has been changed from Grid 1
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EDIT DASHBOARD ITEM FILTER

e To add / edit column filters of a selected control type (dashboard

item), click on Edit Filter on the right click menu.
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Print Preview...
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Export To Image
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Export Dashboard B 1
2d6M ZH0UD Verdon: 1.20.3 TESTAIA - NOTHPCLOOA. 5|

* The Filter Editor screen will be displayed.
* Click onthe red 'And' text in the Filter Editor.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o X

= @
System  New Report
Reports

AP: Rec Outstandng ToTrans X

Home | Vew  Desgn

E # Change Name B _Z L] llll E fb‘ @ EE ]E Q’:‘ 'g‘ E"TII' Y (] Images v @ x ©) ConvertTo v I%I ?E:::d
Title

o e i Gid  Chart Scat Pes Gauges Cards Treemap Choropleth GeoFont Range il B reateox Dupicate  Dele it
iy~ t t  Scatter t ter te Delete
" [ e . Chart " M‘;Zb Mops~  Fiter Eements~ [l Grop S2 Edit Rules " [3 porameters
= =
Dol Seirce DATA ITEMS 5 Mm@ O 0
AP:RecOutstandng ToTrans.. *  Columns
e T
=148 8% T Acount © Eembeta 0«
Account Transactions (Sum)
- [@] AP: Rec Outstanding To Tr. - = oy %o 0
[E] Account e BUYO01 - o
5] Name GAMODL o )
el
[3] Difference =) > MET001 o o
5] Outstandng PNPOO2 =0 =0
Outstendng (Sum) | 35 PRIOOL el =
[E3) Transactions
- SPROO1 156K 156K
Transactions (Sum) ) 3 SPROO2 =121K =121K
U0t =) )
New Column [A] o 16K 16K
Sparidne
P oK Cancel

User : JudthM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL 4|

e This will bring up a drop-down menu with options to change the

current filter selections.
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@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o X

= @
System  New Report
Reports

AP: Rec Outstanding To Trans_ X
tome | Vew  Desgn

Aiors, o RTRAE@OER Y 9% Y 5o @ x oo & sem

sa Pivot  Gid Chart Scatter Pies Gauges Cards Treemap Choropleth GeoPont Range Fil £ et Pt O e et B e cotn
A t t Seatter v t ter te Delete i
" (7 clone 2 v M:‘;' Frrsi Sonents~ T Group £ Edit Rules [ Pacameters
r Edit x
Dota Soirce DATA ITEMS a Y &
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— SPRO01 156K 156K
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New Column ] o 2o i
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Argument oK Cancel

User : JudthM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL

ﬂ;l
* Click on any one to make changes to the filter selection.
* In this image, Not And has been selected.
@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
:
= @
System  New Report
Reports
AP:Rec Outstandng To Trans X &
Home | WView  Design
— - ¢ 0 = - O - AB
Biooe eom- T EE@OEIR WY YR Y S @ X O Bl
Save {3 e . | Pvot Gid  Chat Sg:e‘v Pies  Gauges Cards Treemsp OwM:k!h r:::::u n;: 5::; e Duplcate Deete o Tite 3 s
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S —— Account ¥ Not And Transactions (Sum)
@ o el | [or: — - -
[3E] Name. GAMOOL - =
é]oﬁune Diference () z METO0L Py oy
= PNPO02 0 =
j’?xm Outstandng (Sum) | 2 PRIOOL 0 )
- SPROO1 156K 156K
Transactions (Sum) b SPRO02 =128 121K
SUP01 - -
Mew Coksmn & ToN 16K 16K
Spariine
Argument oK Cancel

User : JudthM  2301/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL él

* Not Add instead of 'And' is now displayed in the Filter Editor.
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@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

B
= @
System  New Report

Reports.

49: Rec Qutstandng ToTrans X .

[

Home | View  Desgn

B Lo wow- Tl E QO S

{58 Change Interval

lE Q'\J f‘ EIT!Y Y (=] tmages ~ @ X © ConvertTo v

[ TextBox « Remove Data ltems.
Save w4y w | Piwot Grid Chart Scatter Pies Gauges Cards Treemap Choropleth GeoPoint Range Fiter 4 Dupicate Delete
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Filter Editor e
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2211881 4% 1 Account “ Raw Data =
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~ (] AP:Rec Outstanding To Tr. : = atbat - =
[&] Account " BUY001 0 0]
[3E] Name GAMODL = -
2 ofference Difference (Sum) | 30 P73 o =
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New Colurmn [&] TON 16K =16K
Sparkine
Arument oK Cancel

User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PCLOCAL

|
. . . .
* In the Filter Editor, click on the Action button.
@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 - o X
] @
System  New Report
[ ap: Recoutstandng ToTrans x | =
\
| Home | Vew = Desion
# ChangelName | .. T m—. (‘ @ == = e O @ ] Images © ComertTo v
E 851 Change Interval = 'III El » - I" ’J ’\‘ b . [] TextBox @ X & Remove Data Items
SV o) e e[ st G i s s GaRRd G e Cirai s s ot ey o Dupbcate Delete o
=
Data Source . DATA ITEMS x wao ‘ &
AP Rec Outstandng To Trans... ~|  Columns
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1081 87 T Acont © ok 0«
— Account Transactions (Sum)
~ [[@] AP: Rec Outstanding To Tr. - — ~ e = =
[&] Account BUYO01 =0 =
[5E] Name GAMOOL = =0
3 Difference Dfference (sum) | ¥ METO01 = =
) Outstandng FIP002 =0 =
Outst
B tonding (Sum) | 5 PRIOO1 = =
. SPRO01 156K 156K
Transactions (Sum) X SPRO02 =121K =121K
- SUPOO1 =0 0
New Column ] TON 16K 16K
Sparkine
Argument oK Cancel
| User: it 23012020 Verson: 1.2.0.3 TESTALPHA- LDMHPCLOCAL /|

A

e A list of actions will be displayed.

e Select the required action.
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@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

B
= @
System  New Report

Reports.

49: Rec Qutstandng ToTrans X

[

Home | View  Desgn

Ao, = BEMEGOER Y YR Y 2 @ X oo & e

[54] TextBox  Remove Data Ttems. [ Edt Colors
Save 4y v | Piwot Grid Chart Scatter Pes Gauges Cards Treemap Choropieth GeoPoint Range Filter 4 Dupicate Delete Titke
() clane Chart Map Maps~  Fiter Bements~ ' Group £33 Edit Rues [3 parameters
Filter Editor e
Data Source R = NotAnd @1 th
AP:Rec Outstandng ToTrans.. ~ Columns W, Add Condition

= P

eiig8) 83 + 7 v Raw Data =+ Add Group th i

Account Transactions (Sum)
~ (@) AP: Rec Outstanding To Tr.
& v 80X0001 0 =
[&] Account - . BUY001 0 =0
[i5] Name: | GAMOOL 2 0
3 fference Difference (Sum) | z METO01 pr- <
5 outstandng P02 =0 -
= Outstandng (Sum) | 35 PRIODL 0 -
§ SPRO01 156K 156K
Transactors (Sum) | X SPRO02 121K 121K
SUPD01 =0 =0
News Column [&] TOH 16K 16K
Sparkine
Aegment oK Cancel

User : JudithM  23/0/2020 Version: 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL

||

* The selected action will be displayed.
¢ Click on the blue text in brackets (these are the column titles).

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 -

AP:Rec Outstandng ToTrans X

Gnd Tools

Home | Vew  Design

#_ Change Name L — - g ), O @ ] Images © ConvertTo > AB G currency
=] coe - ImEAIEQ@OGER W Y[R Y X e
[ Change Interval [5#] TextBox & Remove Data Items. [ Edit Colors.
save fedo v | Pvot Gid Chert Scatter Pes Gauges Cards Treemop Choropleth GeoPoint Range Filter 7 Dupicate Delete __ Tite
(J Cione Chart Map  Mapsv  Fiter Eementsv [ Growp £33 EdtRules [4 Parameters
DBDBSO\IN . DATA ITEMS - NotAnd @ © LIJ
AP:Rec Outstandng ToTrans.. ¥ Columns [Account] Begins with <ent: 70 (¥
e Raw Data 1, 52
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[ Difference e SN i % METOOL 0 =%
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mm Outstandng (sum) | 32 PRIOOL = -
. SPROOL 156K 156K
Transactons (sum) | 53 sPRo0z N StadsiwitiggAarng];iv) 12 =121
SUPOOL =0 =0
New Column @&l Ton 16K 16K
Sparkine
Argumant oK Cancel Aply

| User:JudthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITH PC LOCAL /d_l

* A list of titles will be displayed.
* Click on any of these titles to change the column that is being
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filtered.

* In this image, the Name column has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

AP: Rec Quistandng To Trans X

\'

Home | View  Desgn
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[1#] TextBox « Remove Data Items.
Save = - Pivot Grid Chart Scatter Pes Gauges Cards Treemap Choropleth GeoPont Range Filter . Duplicate Delete Title
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User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL |

* In this image, the Filter Editor will now displays Name as its
column filter instead of Account.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = C X
System

AP:Rec Outstanding To Trans X |

|

| Home | View = Deson

2 ChangeName . == w— (‘ @ == = e O @ =] mages ~ & ComertTo~ AB Gy Curency
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(5D A BUY001 =) 2
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3] Difference Ofference (sum) | 3 s - :
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Outst
) Transactions s ustaning Cund . PRI00L = =
 Transactons (Sum) | P 156K 156K
Transactions (Sum) b 3% SPROD2 =121K 121K
R supoo1 Not startswith{[Namel, 7 L3 .j
New Column 3] TON - -
Sparkline
Argument
oK Cancel Apgly

| User:ludthM 23/01/2020 Version:1.2.0.3 TESTALPHA - LDITHPCLOCAL |

|
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Additional Dashboard Item Options

* Click on any one of the green text. (These are all the methods of
filtering available in this data grid.)

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

= @
System  New Report
Reports.
AP;Rec Qutstanding To Trans X b
—_— - 3 = =
Biom=, cm RTMEQ@OEIR YW Y F Y S0 § X oo f e
& B3 Change Interval B S SO i m_— AR 0 " [15] TextBox e & Remove Data Items [£8] Edit Colors
= t t Seatter Gauges reemap t Range ter : Duplcate Delete e
e () Clone Chart. M::( Maps~  Fiter Eements~ T Growp 12 Edit Rules (g Parameters
Data Source. IDATA [TEMS. - Rev 2 [L]
AP: Rec Outstanding ToTrans... ~ | Cokumns NotAnd @ ©
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F Name %
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oo A TON x16K 16K
Sparkine
Argument
oK Cancel Apply
User : JudéhM  23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL

él

* A pop up menu will display a list of the filter method options for
the selected column.

&l

y

= @
System  New Report
Reports

AP: Rec Qutstanding To Trans X

I

Home | View  Desgn

E 2 Crangetome gy T
B3 Change Interval
o + | Pivot Gad
Data Source DATA ITEMS
AP:Rec CutstandngToTrans.. ~ | Cokumns
=108 8% = T Account
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2] Account 1 e
[iE] Name:
o = Difference (Sum)
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(i3] Transactons )
Transactions (Sum)
New Column
Sparkdine
Argument

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
e B - - »
I E @@= W Y/ Y 2o @ X G
i S R L R & Remove Data Items. E edtColors
Chart Map  Maps™  Fiter Eements~ N Grow £11 EdtRues [3 Parameters
Filter Editor x 1
NotAnd @ © a
= Raw Data [Name] s Begins with |~ ;0 o2
=i Account =t Transactons (Sum)
# Does not equal
v B0X0001 > gt an 0 -
5 PO 3 Is greater than or equal to o o
5 GAMOD1 % wwirie = o
MET0L < Isless thanor equal to e in)
P [ 1sbetween - o
x PRIODL [ 1snot between = ]
SPROO1 #0c Contains =156K 156K
b4 SPRO02 s Does not contain =121K 121K
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#%¢ Isnot ke
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@3 Is any of oK Cancel Angly
@2 1s none of
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@ s not blank

User : JudithM  23/01/2020 Version : 1.2.0.3  TEST ALPHA - JUDITH PC LOCAL /A_I
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* Click on any one of these to select the filter method required.
* In this image the filter method Begins with has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
Ty
=
System  New Report
Reports
AP; Rec Outstanding To Trans X -
i
|| Home | View Design
# Change Name L — e EE @) 0, D =] Images ~ © ConvertTo~ AB G Curency
H v - mEMEQ@GEIRE W H | Y E X Eis
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: SPROOL ¢ Contains =156 158K
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User 04 20U VYerson: 120.3 TESTALAHA -XOTHPCLOCH. |
. . . . . . .
* The Filter Edit I display this filter method ch
e rliter Itor will now displa IS THter metnodad choice.
w AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 - ] X
System  New Report
Reports
AP: Rec Outstandng ToTrans_ X | N
| Home | view  Design
2 d N e . me g §) ol Images v © ConvertTo~ AB &
B - TEE@OSEREY YR Y o X G i
&5 Change Interval - m i = 2] TextBox G & Remove Data Items [ Edit Colors
sa Redo v | Pivot Chart  Scatter P Cards T GeoPoint R ter . te Delete L
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Insert 1
e T . Filter Editor x .
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= S Account Transactions (Sum)
~ [@] AP: Rec Outstanding To Tr . - BOKD00L 0 0
[35] Account S — BUY001 0 0
[3E] Name - GAMOOL =0 =0
1 Ofference i veTwo1 < -
5] Outstanding PNP002 =0 0
Outst (Sum)
= —— tanding (Sum) | X3 PRIODL 0 =0
SPROO1 156K 156K
Transactions (Sum) b 3 SPRO02 121K 121K
ST ot Not Startswith{(Name], ?) % %
‘New ok & TON 16K 16K
Sparkine
Argument
ok Cancel Apply

| User:ludthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL 2|

* Your filter search parameters needs to be appropriate to the

newly selected column and method.
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e Click on the enter a value text.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3

[ 49: Rec Gutstandng To Trans X | -
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| User:JudthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL

LS

* A text box will appear.
* Type in or click on the down arrow and select an appropriate

parameter that applies to this particular column ( Name ) and fil-
ter method ( Begins With ).

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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| User:ludthM 23/01/2020 Version: 1.2.0.3 TEST ALPHA - JUDITHPC LOCAL 2|
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* The text box in the Filter Editor is not case sensitive, you can
type in any part of a word or number.
* In this image, Boxer has been selected.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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1. You can add more filters.

2. You can delete a filter.

3. When you have finished making your filter changes and selections, click
on Apply and Ok to apply these to the dashboard item.
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Additional Dashboard Item Options

AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3
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* The selected filter will be applied to the dashboard item.

* In this image, Boxer is no longer displayed in the dashboard item.
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Additional Dashboard Item Options

CLEAR A DASHBOARD FILTER

e To clear a column filter on a selected control type (dashboard

item), click on Clear on the right click menu.

@ AP: Rec Outstanding To Trans - TEST ALPHA - JUDITH PC LOCAL - REPORTS DASHBOARD V1.2.0.3 = o x
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Sparkine Print Preview.
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* The column filter will be cleared.
* In this image, Boxer is now displayed in the selected dashboard

item.
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PRINT PREVIEW A DASHBOARD ITEM
e Click on Print Preview.
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* The Preview screen will be displayed.
* You can now view the data contained in the dashboard item

before printing.

2 Preview L8 l=]loj x
B Open | B Pt @ |S| [ Margins + i DD evious Page || e | & Zoomout | o a e
1, Quick Print [ Orientation + o Next Page m Q, Zoom ¥
Header/Footer  Scale Find  Thumbnails Ed Firs o, ManyPages B Export | Close
Bl Save | g otions o 0 Siev Fikd: t Page -} - @ Zoomin | B -
Raw Data
\Account  |Name Difference (Sum) Outstanding (Sum) Transactions (Sum)
BOX0001 | Boxer =0 =0 =0
BUY00L Buy Back Supplier =0 =0 =0
GAMODL  |Game =0 =0 =0
MET001 | Metro Peach Distributors =0 =0 =0
PNPOD2  Pick and Pay (Pty)Ltd =0 =0 =0
PRIOO1  |Printer World (Pty)Ltd =0 =0 =0
SPROO1 |Sprint Distributors Lol =0 156K =156K.
SPRO02 Sprint Distril =0 =121K =121K
SUPOD1 | Buy BackSupplier =0 =0 =0
ITON Tonys Copy Shop =0 =16K =16K.
Page 10f 1 | 0% o) L) @ 4

EXPORT TO ....

* You can export data displayed in the dashboard item to PDF or
Image or Excel.
* The Export to Dashboard option gives you the same Export

To... options as above.
® Note: For more information refer to Export To topic.

Help v2024.5.0.7/1.0 - Pg 23 - Printed: 04/07/2024

CO3 Technologies (Pty) Ltd © Company Confidential


#5

cCOO=
Additional Dashboard Item Options
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Related Topics

¢ Change dashboard report title
¢ Set default currency

* Edit dashboard colours

e Change report name

¢ Change report interval

¢ Clone Report

MNU.162.011
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